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OVERVIEW

This application note provides an overview of our C / C++ software code library, which is available for all of our optical digital
sensors except for VCNL4010, VCNL4020, and VCNL3020. There are dedicated software code and application note for these
optical sensors, which can be found here. This application note explains the contents, the structure, and how to use the software
code library. The software code library can be found under the “Design Tools” tab for each of the product page of the digital
sensors in the website. The proximity sensor VCNL4035X01 will be used as an example for this application note. The software
code library for this proximity sensor can be found here under the “Design Tools” tab.

THE CONTENTS OF THE SOFTWARE CODE LIBRARY

The software code file contains “C”, “C++”, and “Project Examples” folders. The “C” and “C++” folders contain the raw
software code, which can be exported into the IDE software application of your selected microcontroller.
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On the other hand, the “Project Examples” folder contains the project files, which can be directly run by clicking the project /
workspace files. The project files are the fastest way to start testing with our sensors, where the software code could be directly
executed, given that the programmer has set up the same pinouts as the one, which has been set up in the project files.
Currently, only STM32F, PSoC® Cypress, and Arduino microcontroller families will be supported for this project examples.
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THE STRUCTURE OF THE SOFTWARE CODE LIBRARY
Source Files Header Files
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Fig. 5 - The Structure of the Software Code Library

The provided software code, which consists of MCU-specific software code and sensor APl as shown in Fig. 5, is designed to
be modular. It means that the programmer can use the sensor API regardless of microcontroller platforms. Only MCU specific
software code has to be added / ported or just use the provided code for the supported platforms.
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This modular approach will reduce the time during the application development regardless of the platform used because only
the MCU-specific software code has to be added / ported for the whole code to work. For example, the programmer can
use/port the examples code in Main.c/ino (For PSoC® Cypress or Arduino platform), Main_User.c (For STM32F platform), and
“Part Name”_Application_Library.c/cpp to quickly initialize different sensor modes, printing sensor register values via COM
Port for debugging purpose as well as some useful application functions like calculating Lux for the ALS sensor and calculating
CCT value using the empirical approach for the color sensor.

The following platforms are supported by the MCU-specific software code:
* PSoC® Cypress

e Arduino and Arduino-supported MCU

e STM32F

Notes

e Vishay does not own the MCU-specific code. The MCU-specific codes, which have been modified, are owned either from Cypress (now
Infineon AG) and STMicroelectronics under the condition that the codes have to be used with their respective microcontrollers. The
MCU-specific code from Arduino can be used, distributed and / or modified under the terms of the GNU Lesser General Public License as
published by the Free Software Foundation

e For Arduino and Arduino-supported MCU - The codes have been tested with Arduino Uno and Teensy3.5. Other Arduino and Arduino-
supported MCU platforms could still work or some small code adjustment might be needed especially with regards to Wire.h/i2c_t3.h library
compatibility

Any other unsupported platforms would require the addition of APl library code in 12C_Functions.h and

12C_Functions.c/cpp.

The comparison of the provided software code files between MCUs and product lines are shown in Fig. 6 and Fig. 7
respectively:

Comparison of the Software Code Files Between MCUs:

* Main.c

® Main_User.c

¢ [2C_Functions.c

® “Part Name”_Application_Library.c
® “Part Name”_PS.c

® “Part Name”_ALS.c

® “Part Name”_RGB.c

* typedefinition.h

* Main_User.h

® |2C_Functions.h

® “Part Name”_Application_Libraty.h
® “Part Name”.h

® “Part Name”_Prototypes.h

* Main.ino

¢ |2C_Functions.cpp

® “Part Name”_Application_Library.cpp
e “Part Name”_PS.cpp

e “Part Name”_ALS.cpp

e “Part Name”_RGB.cpp

o typedefinition.h

¢ |2C_Functions.h

® “Part Name”_Application_Libraty.h
® “Part Name”.h

® “Part Name”_Prototypes.h

* Main.c

¢ |2C_Functions.c

* “Part Name”_Application_Library.c
® “Part Name”_PS.c

® “Part Name”_ALS.c

* “Part Name”_RGB.c
 typedefinition.h

* |2C_Functions.h

® “Part Name”_Application_Libraty.h
® “Part Name”.h

® “Part Name”_Prototypes.h

Fig. 6 - The Comparison of the Provided Software Code Files Between MCUs
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Comparison of the Software Code Files Between Product Lines:

® Main.c/ino

* Main_User.c*

¢ [2C_Functions.c/cpp

® “Part Name”_Application_Library.c/cpp
 typedefinition.h

e Main_User.h*

¢ |2C_Functions.h

® “Part Name”_Application_Libraty.h
® “Part Name”_PS.c/cpp

® “Part Name”.h

® “Part Name”_Prototypes.h

® Main.c/ino

* Main_User.c*

¢ [2C_Functions.c/cpp

® “Part Name”_Application_Library.c
¢ typedefinition.h

e Main_User.h*

¢ |2C_Functions.h

® “Part Name”_Application_Libraty.h
® “Part Name”_RGB.c/cpp

® “Part Name”.h

® “Part Name”_Prototypes.h

® Main.c/ino

* Main_User.c*

¢ [2C_Functions.cpp

* “Part Name”_Application_Library.cpp
 typedefinition.h

® Main_User.h*

e |2C_Functions.h

® “Part Name”_Application_Libraty.h
® “Part Name”_PS.c/cpp

® “Part Name”_ALS.c/cpp

® “Part Name”.h

® “Part Name”_Prototypes.h

® Main.c/ino

* Main_User.c*

¢ |2C_Functions.c/cpp

® “Part Name”_Application_Library.c/
cpp

¢ typedefinition.h

e Main_User.h*

¢ |2C_Functions.h

® “Part Name”_Application_Libraty.h

“Part Name”_ALS.c/cpp

® “Part Name”.h

® “Part Name”_Prototypes.h

* Main_User.c and Main_User.h are only applicable for the STM32F
environment because the Main.c file will be updated every time the project
is relaunched due to the change in the configuration file.

Fig. 7 - The Comparison of the Provided Software Code Files Between MCUs
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HOW TO USE THE SOFTWARE CODE STEP BY STEP

1. STM32F
Step 1: Create a new project in STM32 Cube IDE
Step 2: Configure the pinouts for 12C, RCC, USB_Device, USB_OTG_FS
Step 3: Configure the corresponding USB CDC clock configuration for debugging via COM port purpose
Step 4: Open the “C” folder
Step 5: Add the following files into the STM32 Cube IDE or other supported IDE:
¢ Main.c (From the “STM32F” folder)

Note

® Main.c will be updated to a default code by the STM32 Cube IDE. The three lines of codes (INIT_“Part Name”(), INIT_“Part
Name”(), and PRINT_“Part Name”()), which call the required header file as well as the initialization and printing functions in
Main_User.c, have to be written again when Main.c is updated to the default code after relaunch. The provided Main.c file can
be used as an example of where to add this code if a code rewrite happens

¢ Main_User.c (From the “STM32F” folder)
¢ 12C_Functions.c

¢ “Part Name”_Application_Library.c

e “Part Name”_PS.c

e “Part Name”_ALS.c

e “Part Name”_RGB.c

¢ typedefinition.h

e Main_User.h (From the “STM32F” folder)
¢ |2C_Functions.h

¢ “Part Name”_Application_Library.h

¢ “Part Name”.h

e “Part Name”_Prototypes.h

Step 6: Activate the MCU-specific code in the files 12C_Functions.c, 12C_Functions.h, and “Part Name”_Application_
Library.c by defining #define STM32F in typedefinition.h

Step 7: Set / change the sensor parameters/mode in Main_User.c

Step 8: Run Main.c
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2. PSoC® Cypress

Step 1: Create a new project in PSoC® Creator
Step 2:  Configure the 12C Master component in TopDesign.cysch
Step 3: Configure the corresponding 12C pins
Step 4: Configure the CDC component as well as the USB CDC clock for debugging via COM port purpose
Step 5: Open the “C” folder
Step 6: Add the following files into the PSoC® Creator IDE or other supported IDE:
e Main.c (From the “PSoC Cypress” folder)
¢ 12C_Functions.c
e “Part Name”_Application _Library.c
¢ “Part Name”_PS.c
e “Part Name”_ALS.c
¢ “Part Name”_RGB.c
¢ typedefinition.h
¢ [2C_Functions.h
¢ “Part Name”_Application_Library.h
¢ “Part Name”.h
¢ “Part Name”_Prototypes.h
Step 7: Activate the MCU-specific code in the files 12C_Functions.c, 12C_Functions.h, and “Part Name”_Application_
Library.c by defining #define Cypress in typedefinition.h
Step 8: Set / change the sensor parameters / mode in Main.c
Step 9: Run Main.c
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3. Arduino and Arduino-Supported Platforms Like Teensy

Step 1: Open the “C++” folder
Step 2: Add the following files into the Arduino “libraries” folder (usually the “Part Name” folder has to be created):
¢ |2C_Functions.cpp
¢ “Part Name”_Application_Library.cpp
e “Part Name”_PS.cpp
¢ “Part Name”_ALS.cpp
¢ “Part Name”_RGB.cpp
¢ typedefinition.h
¢ [2C_Functions.h
¢ “Part Name”_Application_Library.h
¢ “Part Name”.h
¢ “Part Name”_Prototypes.h
For example: C:\Arduino\libraries\“Part Name”
Step 3: Add the Main.ino from the “Main” folder into your desired “project” folder, which should be also named as “Main”
and it should be separated from the above “libraries” folder
Step 4: Activate the MCU-specific code in the files 12C_Functions.cpp, 12 Functions.h, and “Part
Name”_Application_Library.cpp by defining #define Arduino in typedefinition.h
Step 5: Activate the code for Arduino platforms by defining #define wirelib in typedefinition.h and comment the line #define
i2ct3. On the other hand, activate the code for Teensy platforms by defining #define i2¢t3 in typedefinition.h and
comment the line #define wirelib
Note
® Arduino platforms use Wire.h library while Teensy platforms use i2¢_t3.h library
Step 6: Open the Arduino sketch
Step 7: Click File > Open
Step 8: Select the directory to your already created “project” folder, which contains the Main.ino
Step 9: Set / change the sensor parameters / mode in Main.ino
Step 10: Run Main.ino
Revision: 05-Aug-2021 8 Document Number: 80289

For technical questions, contact: sensorstechsupport@vishay.com

THIS DOCUMENT IS SUBJECT TO CHANGE WITHOUT NOTICE. THE PRODUCTS DESCRIBED HEREIN AND THIS DOCUMENT

ARE SUBJECT TO SPECIFIC DISCLAIMERS, SET FORTH AT www.vishay.com/doc?91000

310N NOILVOI1lddV


http://www.vishay.com
http://www.vishay.com

VISHAY Application Note

www.vishay.com Vishay Semiconductors

The DNA of tech’

Using The Software Code Library

4. Other MCUs

Step 1:
Step 2:
Step 3:
Step 4:

Step 5:

Step 6:

Step 7:

Step 8:

Step 9:
Step 10:

Create a new project in your selected IDE
Configure the required pinouts, the I2C components as well as the USB CDC components
Open the “C” folder / “C++” folder

Add the following files into the IDE:

¢ |2C_Functions.c/cpp

¢ “Part Name”_Application _Library.c/cpp
¢ “Part Name”_PS.c/cpp

¢ “Part Name”_ALS.c/cpp

¢ “Part Name”_RGB.c/cpp

¢ typedefinition.h

¢ [2C_Functions.h

e “Part Name”_Application_Library.h

¢ “Part Name”.h

¢ “Part Name”_Prototypes.h

Add the 12C API code of your MCU into 12C_Functions.c/cpp or 12C_Functions.h within the #ifdef #endif identifier
statement of your MCU. Please ensure that the restart condition is implemented correctly for the 12C read
command

Activate the MCU-specific code in the files 12C_Functions.c/cpp, 12C_Functions.h, and “Part
Name”_Application_Library.c/cpp by defining #define (write your MCU name) in typedefinition.h

Port the software code from Main.c/ino (from the “PSoC Cypress” / “Main” folder) or Main_User.c (from the
“STM32F” folder) and adapt it in the Main.c/cpp based on your selected MCU environment

Port the software code from “Part Name”_Application_Library.c/cpp as well as “Part
Name”_Application_Library.h and adapt it based on your selected MCU environment. Here, only Print functions are
MCU-specific and the rest are not. Therefore, you can directly use the non-Print functions for your application if
needed

Set / change the sensor parameters / mode in Main.c/cpp

Run Main.c/cpp
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HOW TO USE THE PROJECT EXAMPLES FILES

1. STM32F

Step 1: Create the following directory: C:\Software\STM Project
Note

e STM project is directory-specific. For the project file to be directly executed, the above directory has to be established, where the

“Software” and “STM Project” folders have to be created in “C:”
Step 2:  Open the “Project Examples” folder
Step 3:  Open the “STM32F” folder
Step 4: Copy the “Part Name” folder and paste it into the directory mentioned in Step 1

V| s |STM Project

Home Share View
1 Cut X 47 New item ~

| Easy access ¥

Pinto Quick Copy Paste 5 Move Copy Delete Rename New
aste shortcut . p o
access I8} Pasteshort to~ to~ folder

Clipboard Organize New

™ > This PC > Windows (C:) » Software > STM Project

Name Date modified
> Quick access
VCNL4035X01 3/16/2021 2:21 PM
> @ OneDrive

Fig. 8 - Example Project Directory for the STM32F Platform

Step 5: Go into the “Part Name” folder and then again into the “Part Name” folder
Step 6: Click the .cproject file

24 Open ¥

v

Properties .
- @ History

Edit

Open

Type

File folder
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x l:—‘l & Cut ] x I 03 New item ~ fdopen~ E
\= Copy path ~ {7 Easy access — ’ Edit
Pinto Quick Copy Paste % Move Copy Delete Rename New Properties
access [#] Paste shortcut to~ to~ - folder - @History [
Clipboard Organize New Open
&« v > This PC > Windows (C:) > Software > STM Project > VCNL4035X01 > VCNL4035X01
Name a Date modified Type
> ¥ Quick access
.settings 3/16/2021 2:21 PM File folder
> @ OneDrive Core 3/16/2021 2:21 PM File folder
5> I SharePoint Debug 3/16/2021 2:21 PM File folder
Drivers 3/16/2021 2:21 PM File folder
> S This PC Middlewares 3/16/2021 2:21 PM File folder
> & Network USB DEVICE 3/16/2021 2:21 PM File folder
I [FF .cproject 3/9/2021 3:14 PM CPROJECT File |
|} .mxproject 3/9/2021 3:14 PM MXPROJECT File
[H project 2/1/2021 7:02 PM PROJECT File
0 STM32F407VGTX_FLASH.Id 3/9/2021 3:14 PM LD File
] STM32F407VGTX_RAM.Id 2/1/2021 7:02 PM LD File
[ ] VCNL4035X01 Debug.launch 3/9/2021 4:52 PM LAUNCH File
| ] VCNL4035X01.ioc 3/9/2021 3:14 PM 10C File
Fig. 9 - The Project File for the STM32F Platform
Step 7: Select the directory to be the same as in Step 1 and click Launch
[I] STM32CubelDE Launcher X

Select a directory as workspace

STM32CubelDE uses the workspace directory to store its preferences and development artifacts.

Browse...

C:\Software\STM Project\VCNL4035X01

Workspace: ]

[_] Use this as the default and do not ask again

» Recent Workspaces

Fig. 10 - Select the Directory
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Step 8: Ensure that the following 3 lines exist in Main.c:

EVCNL4035X01 VCNL4035X01/Core/Src/main.c - STM32CubelDE
File Edit Source Refactor Navigate Search PrOJect Run Window Help

3w | ® v R v Gia TS <3 2R GBSy rv@vrihvOryQvi®dew e o vioow v
& Project Explorer “ B @mainc @
BRTY I 219/%

v [2 VCNL4035X01 22 * main.c

¥ Binaries 23 *

24 * Created : 9 November 2020
Rindudes 25 * Modified : 1@ March 2021
v @ Core 26 * Author : HWanyusof
& Inc 27 * Version : 5
v & Src 28| ‘%

29

3@=/* USER CODE END Header */

/% INCIUES == - == mmmmmm e e e e eemeeeeen x/
#include "main.h"

#include "usb_device.h"

18 12C_Functions.c
[4 Main_User.c

w
et

lg main.c
> g stm32f4xx_hal_msp.c

[ stm32f4xx_it.c . .
3 syscalls.c 5 /* Private inCludes =-----======cmmmem--eessseeeeeeeeeeeeeeeeeem——ee—————— x/
e /x_|IcER CONE REGTN Tocludo

¢ sysmem.c |37 #include "Main User.h" ||
9 system_stm32fdxx.c 3

15 VCNL4035X01_ALS.c 39 /* USER CODE END Includes */

DWW W W
phrun s wN

Fig. 11 - Header File “Main_User.h” Needs to be Included in Main.c

[ VCNL4035X01 - VCNL4035X01/Core/Src/main.c - STM32CubelDE

File Edit Source Refactor Navigate Search Project Run Window Help

BvdRI®vQ vain|/pueRo IR @gvalvydrvrGvritvOvyQvi®dy vidi
= B B *mainc 8
Y §| 292

‘& Project Explorer

%% 186 /* USER CODE BEGIN 2 */
& VCNL4035X01 [T67 INIT_VCNL4635Xe1(); |
> 4 Binaries oS =
> & Indudes 109  /* USER CODE END 2 */
v & Core 110

111 /* Infinite loop */

> Inc
. E 112 /* USER CODE BEGIN WHILE */
& Src 113 while (1)
> g 12C_Functions.c 114
> lg Main_User.c 115 /* USER CODE END WHILE */
» g main.c 116

LX _USER _CODE BEGIN 3 _*/

¥ WsRZieiRlinpic | 118 PRINT VCNL4035X01(); |

> g stm32fdxx_it.c 119
> [d syscalls.c 120 /* USER CODE END 3 */
> [9 sysmem.c 121 3
Fig. 12 - The initialization function INIT_”Part Name”() and the printing function PRINT_ “Part Name”() need to be included in Main.c

Note

e Main.c will be updated to a default code by the STM32 Cube IDE. The three lines of codes (INIT_“Part Name”(), INIT_“Part
Name”(), and PRINT_“Part Name”()), which call the required header file as well as the initialization and printing functions in
Main_User.c, have to be written again when Main.c is updated to the default code after relaunch. The provided Main.c file can
be used as an example of where to add this code if a code rewrite happens

Step 9: Run to execute the project
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2. PSoC® Cypress

Step 1: Open the “Project Examples” folder

Step 2: Open the “PSoC Cypress” folder and then “Part Name” folder
Step 3: Click the “Part Name”.cywrk to execute the project

v = | VCNL4035X01

Home Share View
= Cut Y 574 New item ~ Open ~  FH sele
b 4 v
W& Copy path A + Ed

; Easy access ¥ : Sele
Pinto Quick Copy Paste Move Copy Delete Rename New Properties )
ey [#] Paste shortcut e e = folder > = Inve
Clipboard Organize New Open S
« v A > VCNL4035X01 > Project Examples > PSoC Cypress » VCNL4035X01
Name Date modified Type
# Quick access
Backup File folder
@ OneDrive VCNL4035X01.cydsn 3/16/2021 6:17 PM File folder
T |33 venao3sxot.qpwrk 12/15/2020 3:06 PM PSoC Creator Works. |
VCNL4035X01.cywrk.hwanyusof 2/1/2021 10:51 PM HWANYUSOF File
Fig. 13 - Run the PSoC® Cypress Workspace
Step 4: Run to execute the project
3. Arduino and Arduino-Supported Platforms Like Teensy
Step 1:  Open the “Project Examples” folder
Step 2: Open the “Arduino” folder
Step 3: Add the following “Part Name” folder into the Arduino “libraries” folder
v s | Arduino
Home Share View
[ Cut . F7 New item ~ Open ~
B P ‘
* L] Copy path x < T | Easy access ~ Edit
Pinto Quick Copy Paste R e Move Copy Delete Rename New Properties :
Scones u] Paste shortcut to~ to~ % folder = History
Clipboard Organize New Open
<« ¥ 7 > VCNL4035X01 > Project Examples > Arduino >
~ o
Name Date modified Type o
## Quick access
Main 3/16/2021 2:03 PM File folder r
s OnieDrive | veniaossxon 3/16/2021 6:31 PM File folder | O
Fig. 14 - Copy the Arduino Library Files >
—
Step 4: Open “Part Name” folder and open typedefinition.h @)
Z
pz
@)
—
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Step 5:

Step 6:
Step 7:
Step 8:

Step 9:

Using The Software Code Library

Activate the code for Arduino platforms by defining #define wirelib in typedefinition.h and comment the line #define
i2ct3. On the other hand, activate the code for Teensy platforms by defining #define i2¢t3 in typedefinition.h and
comment the line #define wirelib

Note

* Arduino platforms use Wire.h library while Teensy platforms use i2c_t3.h library

Open the Arduino Sketch
Click File > Open
Select the directory to the file Main.ino, which is located in the above “Main” folder

File Edit Sketch Tools Help

+ 03
|
1

sketch_feb15b

&% Open an Arduino sketch... X
Look in: Main v| ege@y
* Name - ¥ Date modified T
Main.ino 2/1/2021 11:30 PM 1]
Quick access
Desktop
]
Libraries
This PC
Network
< >
Objects of type: All Files (*.%) v Cancel

Fig. 15 - Open the Arduino Project
Run Main.ino

If you experience further issues, please contact us via the support E-Mail: sensorstechsupport@vishay.com
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